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1 What is eDASH3k? 

eDASH3K is a visual software application for the configuration of Ama's proprietary CompactCluster, 
SmartView and SlimTitan dashboards. This software can be used to configure inputs, outputs, 
peripheral devices and display graphics of the aforementioned instruments in a simple manner without 
having to alter the source code in C language. This makes the procedure much quicker and easier.
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2 Installing the eDASH3K software 

A PC running Windows 7 Pro or Windows 10 Pro is required to run eDASH3K correctly. Operation on other 
versions of these operating systems is not fully supported. 

To install the eDASH3K software on your PC proceed as follows: 
• Run the setup “edash3k-setup-vX.X.X”. 
• Specify the path for the installation folder and then select Next. 
• Choose: if you want to create a shortcut to the program in the Start Menu press Next otherwise select a 

different folder and press Next. 
• Choose whether to create a desktop icon by means of the Create a desktop shortcut flag and click on the 

Next button. 
• Click on Install. 
• When the installation routine is complete, click on Finish, and select whether or not to run the 

program by means of the Launch eDASH3K flag. 
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3.0.1 Additional commands in drop-down menus - A 

 
Box A shows the Additional commands in drop-down menus. The figure shows the Project menu 
by way of example, in which you can select Close or Exit. 

 
 

 
 
 

• Close • Utility Fonts • Tool Box 
 
 

• Exit • Navigation Tree • Info 
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3.0.2 Main commands - B 

 
Box B shows the Main commands that are used to start configuring the dashboard and select the 
required graphic objects. 

 

 

 
 
 

• New • Redo • 1:1 
 
 

• Open • Paste • Zoom Out 
 
 

• Save • Cut • Run on Device 
 
 

• Save As • Copy • Edit Custom Logic 
 

 
• Print • Delete • 

Custom Logic
 

Help 
 

 
• Undo • Zoom In 
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3.0.3 Specific commands - C 

 
Box C shows Specific commands that are used to configure the dashboard. 

 

 

 
 

 

• 
Background 
Image 

 

• 
Background Colour • Pointer 

 

 

• 
Lamp • MultiLamp • BarGraph 

 
 

• 
Text • Numeric • CameraView 

 
 

• 
HourMeter •      Battery Voltage • DateTime 

• 
Graphics • Button • DTC Table 

 

•     Graphic Version •      Engine RPM •      Filters 

• 
Hardware • Can • Variables 

 
 

•     Maintenance • Passwords • Buzzer 

 
• 

SplashScreen 
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3.0.4 Dashboard components - D 

 
Box D shows all the objects present in the central dashboard. 

 
 

 

Click on the eye which appears alongside the object to hide it from view. 
 

The “eye” button only works on eDASH3K as an assistant in constructing the display layout; the 
objects included in the display are always downloaded and shown on the instrument's display. To 
hide an object on the instrument’s display you can flag the Hide on startup option when available, 
or access the source code (please refer to Chapter 6 and Appendix A). 
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3.0.5 Dashboard - E 

 
Box E shows the complete dashboard. 

 
 

 

 

3.0.6 Object properties - F 

 
Box F shows the properties of the objects selected in box D. 
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3.1 Main commands 
 

3.1.1 New  

Click on New to open the Hardware Type window from which you can launch a new project. 
 

 
• Select the appropriate Hardware Type from the list on the left and click the Finish button: the default 

dashboard is opened and you can start customisation operations. 

 

3.1.2 Open  

Click on Open to open an existing project. 

 
 

3.1.3 Save  

Click on Save to save the current project, overwriting the data of the last saved version. 
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3.1.4 Save As 

Click on Save As to save the current project under a different name, so it does not overwrite the last 
saved version. 

The action creates a folder with the specified name, containing the project and associated images. 

 

3.1.5 Print  

Click on Print to create a PDF file containing the graphic and table related to your settings. 
 

 
 
 

3.1.6 Undo 

Click on Undo to undo your latest actions, one at a time. 

 

3.1.7 Redo  

Click on Redo to redo your latest actions, one at a time. 
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3.1.8 Paste 

Click on Paste to paste a previously copied or cut item into the selected area. 

 

3.1.9 Cut  

Click on Cut to cut the selected element, while retaining it in the memory, so, for example, it can be 
pasted into a different position. 

 

3.1.10 Copy  

Click on Copy to copy the selected element so it can be pasted into a different position. 

 

3.1.11 Delete  

Click on Delete to remove the selected element without retaining it in the memory. 

 

3.1.12 Zoom In  

Click on Zoom In to increase the dashboard display size. 

 

3.1.13 1:1  

Click on 1:1 to reset the dashboard display size. 

 

3.1.14 Zoom Out  

Click on Zoom Out to decrease the dashboard display size. 
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3.1.15 Run on Device  

Click on the Run on Device icon to compile and download the project in the instrument’s memory. 
 

If an insufficient memory space message appears, use the image compression tools available in 
the Exported Formats option for some of the graphic objects described below in order to minimise 
memory requirements. 

CAUTION! Image compression could result in deterioration of final quality. 
 

The instrument to program must be connected to the PC by means of the PEAK USB-CAN 
converter, model PCAN-USB. See Chapter 5 for details on  installing and setting up the converter. 
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3.2 Drop-down menu commands 

3.2.1 Project → Close  

Click on Close, located in the Project drop-down menu, to close the project currently in use. 

 

3.2.2 Project → Exit  

Click on Exit, located in the Project drop-down menu, to exit from the application. 

 

3.2.3 Project → Examples  

Click on Examples, located in the Project drop-down menu, to open any of the example projects provided with 
eDASH3K. Projects are grouped by hardware type. 

 

3.2.4 Edit → Utility Fonts  
 

This function is available only for the “Compact Cluster” and “SmartView” Hardware Type. 

 
This function is used to solve a problem while displaying the preloaded fonts in the CCluster when 
using eDASH3K on computers with very high resolution displays (e.g. MAC retina). 
Click on Utility Fonts, located in the Edit drop-down menu, to change the font for texts for which there is 
no specific setting. 

 

If no display errors occur within the dashboard, thus implying there is no font incompatibility, it is 
highly advised not to change these settings. 

 
 

3.2.5 View → Navigation Tree  

Flag the Navigation Tree option, located in the View drop-down menu, to show or hide the list of 
dashboard components, on the left. 

 

3.2.6 View → Tool Box  

Flag the Tool Box option, located in the View drop-down menu, to show or hide the dashboard components’ 
editing options, on the right. 

 

3.2.7 Help → Info  

Click on Info, located in the Help drop-down menu to show details about application version. 
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3.2.8 Help → Manual  

3.2.9 Help → Manuale  

Click on Manual, located in the Help drop-down menu to open this document in PDF format. You have 
the choice of opening it either in English (Manual) or in Italian (Manuale). 
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3.3 Specific commands 

3.3.1 Add Page  
 

Click on the Add Page button on the upper right corner, to add a page to the project, corresponding to a 
dashboard screen in addition to MainView. Click on the “x” alongside the page name to delete it. 

 
 

MainView can’t be deleted. 
 
 

Switching from one page to another must be managed using source code (refer to Chapter 6 and 
Appendix A). 

 

3.3.2 Background  
 

This function is available only for the “Slim Titan” Hardware Type.  

Click on Background to set the display background image. 

 
 
 
 
 
 
 
 
 

 
 

• Once you have set up the background image you can edit it by clicking the box alongside Bk Image. 
• Click the box alongside Bk Color to set the background colour. 
• Click on the button with the image of the trash bin (called Drop Image) to remove the image 

inserted in that area. 

 

The maximum overall uncompressed size of background images cannot exceed 1,5 MB. 
 



- 22 - 

eDASH3K User Manual 

 

 

 
 
 

3.3.3 Pointer 
 

This function is available only for the “Slim Titan” Hardware Type. 

 
Click on Pointer to open the pointer tools creation and insertion window. 

• To insert one of the pre-set pointers in the dashboard click on the chosen pointer (the values 
between brackets are its dimensions) and click the Insert to Display button. 

• To create a new pointer click on New, upload the image by clicking Select Image and set the pointer 
rotation point by setting the X and Y values in the Rotation Point box. 

• Once you have created a new pointer you can delete it by selecting it and clicking on Delete. 
• Click Cancel to exit the window. 

 

 
 

• If required, enter the name of the pointer in the field Name. 
• Set the position of the indicator inside the display by dragging it with the mouse pointer or by changing 

the values X (Left), Y (Top), X (Right) and Y (Bottom). 
• Use the Centering buttons to automatically place the pointer at the horizontal or vertical centre of the 

display. 
• Click on the drop-down list alongside Signal to associate an input (Pin), a Can message (Can) or a 

variable (Var) with the pointer. 
• Click the box alongside Image to replace the selected pointer with a different one.  
• Click on the gear icon alongside to Image to access the Rotation Point Offset setting, that is the position 

of the fulcrum of the Pointer rotation (the X and Y coordinates are referred to the first pixel in the upper 
right of the image of the object). 
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• Click the box alongside Crown to add another image to the display as a numbered curvilinear 

scale for the pointer. 
 

For reasons related to the display hardware, the crown associated with the indicator is automatically 
joined to the background on the page; the calculation of the memory used for the background reflects 
this situation. This means that a monochrome background could look like occupying more than the usual 
few kB, because the crown is made to be part of the background itself. 

 
• Click on the button with the image of the trash bin (called Drop Image) to remove the image 

inserted in that area. 
• Set the angle that defines the pointer start or zero position, editing the value in the box 

alongside Start. 
• Set the angle that defines the pointer end position, editing the value in the box alongside End. 
• By connecting an input of any type to the indicator, a table is displayed; it allows you to map in detail 

the behaviour of the pointer to the varying input values. The following example shows a simple 
mapping that assigns an appropriate range of values to the input values (shown in the right column 
with the unit of measurement possibly associated with the signal, in this case a CAN message 
showing the number of engine RPM). This way, the user can set the values corresponding to the 
Start and End positions of the indicator. The Start position is always associated with the first 
element of the table (in the example, the row with value 0), while the End position is always 
associated with the last element (in the example, the row with value 4000). 

 
 

 
 
 

The table above mentioned can also be used to further detail the linearity of movement of the pointer: for 
example, in the case just discussed, receiving an input value equal to 2000 will make the pointer 
automatically position itself in the middle of the scale, because the input value corresponds to half of the 
maximum input value. This same behaviour would be obtained even if the user explicitly specified that 
the value 2000 corresponds to the middle position in the table, for example by associating it with a value 
corresponding to half of the maximum that can be represented: 
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Finally, the table allows the user to alter the linearity of the movement of the hand: if the user would set 
the middle value of the table to an input value that does not coincide with half the maximum value, he 
would obtain two different behaviours of the indicator, below and above that value: 
 

 
 
In the example represented above, the indicator would use the first half of the scale (from 0 to 50%) to 
portray input values from 0 to 1000 (i.e. only 25% of the possible input values), and then use the 
remaining 50% to portray values from 1001 to 4000, obtaining therefore two different levels of linearity 
within the same object. 
 

• Set the pointer speed, editing the value in the box alongside Mov.Duration. 
• Pointer direction of rotation is clockwise by default; flag the Anti-Clockwise option to set it as anti-

clockwise. 
• Click on Hide on startup to hide the object at the device startup; you can make it visible again during 

device operation by means of the source code (please refer to Chapter 6 and Appendix A). 
• For a preview of the pointer, press Test. 

 

When rotation parameters are changed (Start and/or End and/or Rotation Point Offset), you 
must click on Test to update the Pointer depiction on the screen. 
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3.3.4 Lamp  

Click the Lamp icon to access the window for creation and insertion of indicator lamps on the display. 

• To insert one of pre-set indicator lamps in the dashboard, click on the chosen lamp (the values 
between brackets are its dimensions) and click the Insert To Display button. 

• To create a new indicator lamp, click New, upload the image you want to display when the indicator 
is On by clicking Select On Image, upload the image you want to display when the indicator is off by 
clicking Select Off Image and then click Ok. 

 

For good visibility on the display we recommend creating indicator lamps of around 80x80 px in size. 
 
 

• After having created a new indicator lamp, you can remove it by selecting it and clicking Delete. 
• Click Cancel to exit the window. 

 

 
 

• If required, type the name of the indicator lamp in the field alongside Name. 
• Set the position of the item on the display by dragging it with the mouse pointer or by changing the 

values X (Left), Y (Top), X (Right) and Y (Bottom). 
• Use the Centering buttons to automatically place the item at the horizontal or vertical centre of the 

display. 
• Click on the drop-down list alongside Signal to associate an input (Pin), a Can message (Can), a 

special function (Special) or a variable (Var) with the indicator lamp. 
• Click the box alongside Image On to select and upload the image you want to display when the 

indicator lamp is lit.. 
• Click the box alongside Image Off to select and upload the image you want to display when the 

indicator lamp is off. 
• Click on the button with the image of the trash bin (called Drop Image) to remove the image 

inserted in that area. 
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If no Image Off image is uploaded, when the indicator lamp is off it disappears completely. 
 
 

• Flag the Activate Warning Lamp checkbox to associate indicator activation with the warning 
lamp. 

 
 

Activate Warning Lamp is only available on “Compact Cluster” devices. 

 
• Flag the Activate Buzzer checkbox to associate indicator activation with the audible signal. 
• Click on the gear icon alongside Image On or Image Off to open the image compression window. 

• Click on the drop-down list alongside Exported Format to select the format in which to export the 
image. 

• In the Info box you can display the image dimensions (Image), the original file size (Original Size) 
and the size after the chosen compression type (Exported Size). 

• You can compare the effects of compression on the image in the Original Image and Export Preview 
windows. 

• Click on Hide on startup to hide the object at the device startup; you can make it visible again during 
device operation by means of the source code (please refer to Chapter 6 and Appendix A). 

• For a preview of the lamp, press Test. 
• To set the behaviour with which the light should light up, set the Threshold and Tolerance values, then 

select the required activation mode from the Active drop-down list: 
• Above threshold means that the lamp will light up when values equal to or greater than 

Threshold are reached; once lit, the lamp will remain so even below Threshold as long as the 
value stays within Tolerance. 

• Below threshold: means that the lamp will light up when values equal to or lesser than 
Threshold are reached; once lit, the lamp will remain so even above Threshold as long as the 
value stays within Tolerance. 

• Equal to threshold: means that the lamp will light up when values strictly equal to Threshold 
are met; once lit, the lamp will remain so even above and below Threshold as long as the 
value stays within Tolerance. 
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3.3.5 MultiLamp  

Click the MultiLamp icon to insert and configure the indicator lamps on the display. 

 

• If required, type the name of the indicator lamps group in the field alongside Name. 
• Set the position of the item on the display by dragging it with the mouse pointer or by changing the 

values X (Left), Y (Top), X (Right) and Y (Bottom). 
• Use the Centering buttons to automatically place the item at the horizontal or vertical centre of the 

display. 
• Click the box alongside Image Off to select and upload the image you want to appear when none 

of the indicator lamps are on. 
• Click on the button with the image of the trash bin (called Drop Image) to remove the image 

inserted in that area. 
• Click on the + symbol to create new indicator lamps to be included in the indicator lamps group. 
• In the Children Lamps box you can remove and/or sort the indicator lamps using the - symbol and the 
• arrow buttons. 

• Click on Hide on startup to hide the object at the device startup; you can make it visible again during 
device operation by means of the source code (please refer to Chapter 6 and Appendix A). 

• For a preview of the indicator lamps group, click on Test. 
 

If only one of the selected indicator lamps is active, it will be displayed individually. Conversely, 
if there are simultaneously several active indicator lamps among those selected, they will be 
displayed cyclically. 
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3.3.6 BarGraph 
 
Click the BarGraph icon to open the bar graph creation and insertion window. 

• To insert a pre-set bar graph in the dashboard, click on the required bar (the values between brackets 
are the dimensions) and click the Insert To Display button. 

• To create a new bar graph, click New, upload the image you want to display when the bar is 
completely full by clicking Select On Image, upload the image you want to display when the bar is 
completely empty by clicking Select Off Image, set up the orientation of the bar (horizontal / vertical) 
and then click Ok. 

• After having created a new bar you can remove it by clicking Delete. 
• Click Cancel to exit the window. 

 
Once you have inserted the bar graph in the display, it can be customised. 
 

 

• If required, type the name of the bar in the field alongside Name. 
• Set the position of the item on the display by dragging it with the mouse pointer or by changing the 

values X (Left), Y (Top), X (Right) and Y (Bottom). 
• Use the Centering buttons to automatically place the item at the horizontal or vertical centre of the 

display. 
• Click on the drop-down list alongside Signal to associate an input (Pin), a Can message (Can) or 

a variable (Var) with the bar graph. 
• Click the box alongside Image On to select and upload the image you want to display when the 

bargraph is completely full.  
• Click the box alongside Image Off to select and upload the image you want to display when 

the bar graph is completely empty. 
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• Click on the button with the image of the trash bin (called Drop Image) to remove the image 

inserted in that area. 
• Set the number of steps on the bar, editing the value shown in the box alongside Step 

• Set the filling direction of the bar (right to left / left to right) by clicking on the drop-down list alongside 
Fill Type. 

• Click on the gear icon alongside Image On or Image Off to open the image compression window. 

 
 

• Click on the drop-down list alongside Exported Format to select the format in which to export the 
image. 

• In the Info box you can display the image dimensions (Image), the original file size (Original Size) 
and the size after the chosen compression type (Exported Size). 

• You can compare the effects of compression on the image in the Original Image and Export Preview 
windows. 

• Click on Hide on startup to hide the object at the device startup; you can make it visible again during 
device operation by means of the source code (please refer to Chapter 6 and Appendix A). 

• For a preview of the bar graph, click on Test. 
• To set the value and tolerance related to each step of the bar, use the appropriate table: for each step you 

must set the value to be met for lighting up (in the second column), while in the Tolerance column you can 
set the interval below which that specific step maintains the lighting after having previously achieved it. 
Tolerance values can be different from one step to another. 
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3.3.7 Text  
 
Click on the Text icon to insert a static text on the display. 
 

 

• If required, type the name of the text box in the field alongside Name. 
• Set the position of the item on the display by dragging it with the mouse pointer or by changing the 

values X (Left), Y (Top), X (Right) and Y (Bottom). 
• Use the Centering buttons to automatically place the item at the horizontal or vertical centre of the 

display. 
• Type the required text into the box alongside Text. 
• Set the font and font size by clicking the box alongside Font. 
• The text contained and the selected font determine the default size of the Text object. However, you can set 

the desired size for the object by selecting the Lock Size option and entering the required values in the Text 
Width and Text Height boxes. 

• By enabling the Lock Size option, you also have the ability to specify the horizontal (H. Alignment) and 
vertical (V. Alignment) orientation for the text contained in the Text object, using the appropriate buttons. 
 

The Lock Size option is only available on Hardware Type “Slim Titan”. 
 

• Set the text colour by clicking the box alongside Fg Color. 
• Click on Hide on startup to hide the object at the device startup; you can make it visible again during 

device operation by means of the source code (please refer to Chapter 6 and Appendix A).. 
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3.3.8 Numeric 
 
Click on the Numeric icon to insert a dynamic numerical value on the display. 

 

• If required, type the name of the numerical value in the field alongside Name. 
• Set the position of the item on the display by dragging it with the mouse pointer or by changing the 

values X (Left), Y (Top), X (Right) and Y (Bottom). 
• Use the Centering buttons to automatically place the item at the horizontal or vertical centre of the 

display. 
• Click on the drop-down list alongside Signal to associate an input (Pin), a Can message (Can), a 

special function (Special) or a variable (Var) with the numerical value. 
• Set the font and font size of the numerical value by clicking the box alongside Font. 
• Set the number of digits of the numerical value, editing the value in the box alongside Length. 
• Set the number of decimal places of the numerical value, editing the value in the box alongside 

Decimal. 
• If you want to convert the numerical value entered in order to display a computed value rather than 

the original number, set the values A, B and C in accordance with the formula shown above them. 
• Set the alignment of the digits by means of the three H. Alignment options. 
• The Reserve space for negative symbol option can be selected to make sure that, in case of right or 

centre alignment, the actual position in which the digits are represented takes into account any space 
needed to represent the "-" symbol for negative values. Therefore the digits will remain equally aligned for 
both positive and negative values. 

• The number of digits, negative symbol and the selected font determine the default size of the Numeric 
object. However, you can set the desired size for the object by selecting the Lock Size option and entering 
the required values in the Text Width and Text Height boxes. With the Lock Size option active, the 
minimum acceptable sizes are the minimum necessary to correctly display the number of digits indicated, 
with the selected font, regardless of the actual value represented. 

• By enabling the Lock Size option, you also have the ability to specify the vertical (V. Alignment) 
orientation for the value contained in the Numeric object, using the appropriate buttons. 
 

When the Lock Size option is not enabled, it is still possible to select the horizontal alignment of the 
numerical value, which however will refer to the maximum possible width of the value to be 
represented based on the number of digits, the font selected and whether it is expected or minus the 
negative symbol. 
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 The Lock Size option is only available on Hardware Type “Slim Titan”. 
 

• Set the colour of the numerical value by clicking the box alongside Fg Color. 
• Set the symbol to be used to represent the not significant digits by clicking on the option buttons alongside 

Fill. 
• Click on Hide on startup to hide the object at the device startup; you can make it visible again during 

device operation by means of the source code (please refer to Chapter 6 and Appendix A). 
 
 

3.3.9 Camera View  

To implement the Camera View command, it is necessary to directly alter the source code of the 
device (refer to Chapter 6). Open Custom Logic Help and read the description of the 
camera_activate (int channel) function. 

 
 

3.3.10 Hour Meter 
 
Click on the HourMeter icon to insert a dynamic numerical value (Numeric) on the display; note that the 

numeric is already preconfigured as a counter. 

 

 
 

The HourMeter function is used to count the engine running hours; this is a factory-set function and hence 
does not require any further settings. 

To customise the function, refer to the instructions for the Numeric settings. 
 
 

By default the engine running hours count starts only when engine speed reaches 300 rpm. 

 
For more information on button A refer to heading 3.3.17. 

For more information on button B refer to heading 3.3.18. 
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3.3.11 Battery Voltage 
 
Click on the Battery Voltage icon to enter the battery voltage value.  
The Battery Voltage button is used to enter a Numeric (see heading 3.3.8) in which the battery settings are 

already preconfigured. 

 

 
 

For more information on button A refer to heading 3.3.18. 
 
 

3.3.12 DateTime  
 
Click on the DateTime icon to enter a time or date object in the display. 
 

 
 
Edit the properties of the object to select the required time or date format. On each page it is possible to enter a 

maximum of 2 DateTime objects, one for the time and one for the date. 
• If required, type the name of the object in the field alongside Name. 
• Set the position of the item on the display by dragging it with the mouse pointer or by changing the 

values X (Left), Y (Top), X (Right) and Y (Bottom). 
• Use the Centering buttons to automatically place the item at the horizontal or vertical centre of the 

display. 
• Set the font and font size by clicking the box alongside Font. 
• Set the text colour by clicking the box alongside Fg Color. 
• Click on the drop-down list alongside Format to select the date format (year-month-day, day-

month-year, etc.). 
• Click on the drop-down list alongside Time Format to select the hour format choosing among 12 hrs 

and 24 hrs. 
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• Click on Hide on startup to hide the object at the device startup; you can make it visible again during 

device operation by means of the source code (please refer to Chapter 6 and Appendix A). 
• Click on the drop-down list alongside Date Format to set the number of digits to be used while 

representing the year, choosing among 2 and 4 digits. 
 

To implement the date and time editing functions it is necessary to directly modify the device’s 
source code (please refer to Chapter 6 and Appendix A). 
An example can be found in the Examples folder, contained in the eDASH3K installation path. 

 

3.3.13 Graphics  
 
Click on the Graphics icon to insert a static image on the display. 
 

 

• If required, type the name of the image in the field alongside Name. 
• Set the position of the item on the display by dragging it with the mouse pointer or by changing the 

values X (Left), Y (Top), X (Right) and Y (Bottom). 
• Use the Centering buttons to automatically place the item at the horizontal or vertical centre of the 

display. 

• Click on Hide on startup to hide the object at the device startup; you can make it visible again during 
device operation by means of the source code (please refer to Chapter 6 and Appendix A). 

• To change the chosen image click in the box alongside Image. 
• Click on the gears icon alongside Image to open the image compression window. 

 

 
 

• Click on the drop-down list alongside Exported Format to select the format in which to export the 
image. 

• In the Info box you can display the image dimensions (Image), the original file size (Original Size) 
and size after the chosen compression type (Exported Size). 

• You can compare the effects of compression on the image in the Original Image and Export Preview 
windows. 
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3.3.14 Button  
 

This function is available only for the “Slim Titan” Hardware Type. 

 
Click on the Button icon to open the button creation and insertion window. 

 
 

 

• To insert a pre-set button in the dashboard, click on the required button (values between brackets 
are its dimensions) and click the Insert To Display button. 

• To create a new button, click New, upload the image you want to display when the button is 
pressed by clicking Select Pressed Image, upload the image you want to display when the 
button is released by clicking Select Released Image (the former will get enabled after the latter 
has been set); you can view its width and height in the Size box at the bottom. 

• During the creation of the object, it is possible to delete everything that has been entered, using 
the Reset button. 

• Click on Cancel to exit the window. 
 

 
 

• If required, type the name of the button in the field alongside Name. 
• Set the position of the item on the display by dragging it with the mouse pointer or by changing the 

values X (Left), Y (Top), X (Right) and Y (Bottom). 
• Use the Centering buttons to automatically place the item at the horizontal or vertical centre of the 

display. 
• Click on the boxes alongside Image Released and Image Pressed to select and upload the images you 

want to display when the button is released or pressed, respectively. 
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• Click on the trash bin button (called Drop Image) to remove the image inserted in that area. 
• Click on the gear icon alongside Image Released or Image Pressed to open the image compression 

window. 
• Click on the drop-down list alongside Exported Format to select the format in which to export the 

image. 
• In the Info box you can display the image dimensions (Image), the original file size (Original Size) 

and the size after the chosen compression type (Exported Size). 
• You can compare the effects of compression on the image in the Original Image and Export Preview 

windows. 
• Click on Hide on startup to hide the object at the device startup; you can make it visible again during 

device operation by means of the source code (please refer to Chapter 6 and Appendix A). 
• For a preview of the button, press Test. 

  



- 37 - 

eDASH3K User Manual 

 

 

 

3.3.15 DTC Table  

Click on the DTC Table icon to insert the DTC table on the display. 
 

DTCs are CAN line Diagnostic Trouble Codes (see standard SAE J1939). 
 
 

The messages displayed are those sent by the engine, classified according to the SAE J1939 protocol as 
DM1 (Diagnostic Message 1). 
SPN = SuspectParameterNumber. It is a number associated with a particular parameter (for example the 

temperature of the engine oil, or the status of a warning light, etc.). 
FMI = Failure Mode Identifier. It is a number that indicates the type and severity of the problem associated with 

the object indicated by the SPN. The value goes from 0 to 31. 
OCC = OccurrenceCounter. Indicates the number of times a certain error message is sent by the engine. 

 
For additional information, see standard SAE J1939. 

 

 
 
If required, type the name of the table in the field alongside Name. 

• Set the position of the item on the display by dragging it with the mouse pointer or by changing the 
values X (Left), Y (Top), X (Right) and Y (Bottom). 

• Use the Centering buttons to automatically place the item at the horizontal or vertical centre of the 
display. 

• Set the size of the table by setting the W (width) and H (height) values. 
• Set the number of rows in the table, editing the value in the box alongside Rows. 
• In the drop-down list alongside Cols select the columns to be represented (SPN and FMI / SPN, FMI 
• and OCC). 
• Set the type of conversion to be carried out in the case of bit CM = 0 under the SPN Fmt 0 entry. 
• Set the type of conversion to be carried out in the case of bit CM = 1 under the SPN Fmt 1 entry. 
• Check the Enabled box beside the SRC Mask option if you want to set the filter for the source of the BAM 

messages. The filter must be set in hexadecimal value. 
 

CM (Conversion Method) indicates the type of conversion to be performed to interpret the message, to be 
chosen from 4 different types. This data is indicated by the engine manufacturer in the specification 
document; if there are no indications, leave the default value. 
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• Choose whether to show or hide the header by flagging/unflagging the checkbox alongside Headers 
Visible. 

• Click on Hide on startup to hide the object at the device startup; you can make it visible again during device 
operation by means of the source code (please refer to Chapter 6 and Appendix A). 

• Set the font and font size of the text in the table by clicking the box alongside Font. 
 
 

Select a suitable size font: selecting a font that is too big with respect to the table size will result 
in problems of visibility of the table. 

 
• Set the table background colour by clicking the box alongside Bk Color. 
• Set the colour of text in the table by clicking the box alongside Fg Color. 

 

In the “Compact Cluster” Hardware Type, if the DTC Table object is not present in the display, it is 
still possible to view a list of the DTCs in a page implemented by default and accessible by holding 
down the Enter key for 4 seconds. 

 
 
 

3.3.16 Graphic Version  
Click on the Graphic Version icon to open this window where you can assign a version number to the project. 

 
Graphic Version allows the user to assign a version to the new project underway.  
It is possible to see the version number in the instrument's menu under Info, which can be displayed on the 

instrument by pressing the UP and DOWN buttons simultaneously for 4 seconds, within the first 10 seconds 
after the dashboard is turned on. 

 

This feature is not available on the “Slim Titan” Hardware Type. 
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3.3.17 Engine RPM  

Click on the Engine RPM icon to open the engine rpm set-up window. 
 

 

• Click on the drop-down menus on the Engine RPM from line to set the engine rpm information input 
point. 

• Click on CAN to display the frequency input in RPM (see example A); click on PIN to display the frequency 
input in tenths of Hz (see example B). 

• The second line is used to set the RPM threshold to identify an engine start. 
• If you want the Hour Meter to work constantly, regardless of whether or not an input value is present, you 

must set the threshold to 0 and provide any CAN message as input (it can also be a dummy message, 
entered in the Can page but never sent within the network). 

• If, on the other hand, a frequency input (PIN) is used, to make the Hour Meter operating continuously it is 
essential that the signal regularly provides the minimum threshold value. 

• The Hour Meter (see heading 3.3.10) starts counting when the set RPM threshold is reached. 
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3.3.18 Filters  

Click on the Filters icon to apply software filters on the selected signals: physical inputs, CAN messages, 
software (special functions of the instrument). 
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Filters description 
 

• Moving Average: moving average filter 
• nsamples: number of samples 

 
• Noise Cancelling Type 1: moving average filter with noise and spike correction, maximum value 

clamping and nearest multiple truncation 
• nsamples: number of moving average samples 
• noise_perc: percentage of current sample variation (compared to current average value) below 

which the sample is considered noise and therefore rejected 
• spike_perc: percentage of current sample variation (compared to current average value) above 

which the sample is considered a spike. Upon receiving a spike, the filter resets the current average 
and sets it as equal to the current sample (to follow "fast" signal variations) 

• sample_max: maximum value allowed for the sample (clamping). 
• truncation: truncation of the average to the nearest multiple (e.g.: if 20, the current average is 

calculated as the average ÷ 20 x 20) 
 

• Noise Cancelling Type 2: moving average filter with noise and spike correction and maximum value 
clamping. Management of spikes (quick variations) only occurs after having received a certain number 
of samples with values very different to the current average 

• nsamples: number of moving average samples 
• noise_delta: delta (expressed as an absolute value) compared to the current average above which a 

sample is considered a "significant variation" of the signal 
• spike_delta: delta (expressed as an absolute value) compared to the current average within which a 

sample is considered a "small variation" of the signal and is therefore rejected. 
• max_ndiscard: maximum number of samples considered "significant variations" which can be rejected 

before the current moving average is reset 
• sample_max: maximum value allowed for the sample (clamping). 

 
 

Preset descriptions 
 

Moving Average Very Light 
• nsamples: 4 

 
Moving Average Light: 
• nsamples: 16 

 
Moving Average Medium: 
• nsamples: 64 

 
Moving Average Strong: 
• nsamples: 128 

 
Noise Cancelling Type 1 Very Light 
• noise_perc: 3 
• nsamples: 4 
• sample_max: 5000 
• spike_perc: 50 
• truncation: 20 
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Noise Cancelling Type 1 Light: 
• noise_perc: 3 
• nsamples: 16 
• sample_max: 5000 
• spike_perc: 50 
• truncation: 20 

 
Noise Cancelling Type 1 Medium: 
• noise_perc: 3 
• nsamples: 64 
• sample_max: 5000 
• spike_perc: 50 
• truncation: 20 

 
Noise Cancelling Type 1 Strong: 
• noise_perc: 3 
• nsamples: 128 
• sample_max: 5000 
• spike_perc: 50 
• truncation: 20 

 
Noise Cancelling Type 2 Very Light 
• delta_noise: 300 
• delta_spike: 20 
• max_ndiscard: 10 
• nsamples: 4 
• sample_max: 5000 

 
Noise Cancelling Type 2 Light: 
• delta_noise: 300 
• delta_spike: 20 
• max_ndiscard: 10 
• nsamples: 16 
• sample_max: 5000 

 
Noise Cancelling Type 2 Medium: 
• delta_noise: 300 
• delta_spike: 20 
• max_ndiscard: 10 
• nsamples: 64 
• sample_max: 5000 

 
Noise Cancelling Type 2 Strong: 
• delta_noise: 300 
• delta_spike: 20 
• max_ndiscard: 10 
• nsamples: 128 
• sample_max: 5000 
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3.3.19 Hardware 

Click on the Hardware icon to activate the window to display and set up the available pins. 

• Click on the drop-down lists in the Type column to set the input signal type on the pins (digital, can, 
analogue, etc.). 

• Enter the Key in flag to set the input signal type of pin 15 (digital / key in). 
• Enter the Uart flag to enable UART port functionalities in custom logic (only on Smart View hardware); 

remove the flag to slightly increase the memory amount available for custom logic code. 
• Set the New Display flag to enable support for the new 2.4” display (in use since November 2021). 
• The Board Type option allows to switch between Classic and Simple variants, that is between standard 

Slim Titan model and the simplified one that has limited functionalities. 
 

The Board Type option is available only for the “Slim Titan” Hardware Type. 
 
 
 

 

3.3.20 Can  

Click on the Can icon to open the window for creation and set-up of incoming messages on the CAN BUS 
line. 
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To add a new CAN message: 

• Type the message name in the Name text box 
• Type the message ID in the Id text box 
• In the drop-down list which appears in the window between Id and Unit, select the length of the 

message Id field choosing between 11- or 29-bit.. 
• Select the measurement unit to be associated with the message choosing from the Unit drop-

down list (optional operation). 
 
 
 

• Enter the number of bytes required for the message in the Dlc box. 
• Select which bits are associated with the message, flagging or unflagging the checkboxes. The set 

of selected bits represents the value you wish to manage (just one value for each message created). 
• To select / deselect each bit of a specific byte you can use the "Set / Unset All" button 
• Click on Add to save the new message. 

 

To edit an existing message: 

 
• Select the message by clicking on any box in the relevant row. 
• Click on Edit to display the values in the upper section of the window and modify them. 
• Change the displayed values as required. 
• Click on Add to save the modified message. 

 
 

Each selected bit must belong to consecutive bytes. Also consider that bytes are represented in 
ascending order; for example, imagining that you have a message that uses bytes 4 and 5, and you 
want to transmit the FF00 value, this would be represented with its lower part (00) in the 4th byte, while 
the upper part (FF) would be represented in the 5th byte.  

 
 

• If you wish to pre-process the incoming message, edit values A, B and C, in accordance with the 
formula shown above them. The formula pre-processes the previously selected value and represents 
the X value of the formula. 

 
 

The messages created will appear in the Signal menu during instrument configuration. 
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3.3.21 Variables  

Click on the Variables icon to open the variables display and set-up window. 

• Click the text field of the Name column to customise the name of the variables. 
• Click on the drop-down lists in the Unit column if you wish to associate a measurement unit with the 

variable. 
• In the Usage column you can see whether or not the variable has been associated with an object. 

 

Variables can be linked to graphic elements but, unlike for the other linkable elements, to edit the 
settings you need to open the Compact Cluster firmware source code and create a function that 
sets the value (consult the specific heading for more information). 
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3.3.22 Maintenance 

Maintenance Timers can be considered as numbers which are decreased as long as the internal HourMeter of 
the device (when available) is running. They start at the Set value and run until they reach zero; the user can 
then make them restart from their Reset value or from an arbitrary value by means of Custom Logic. 

Click on the Maintenance icon to open the Maintenance Timer set-up window. 

 

• Maintenance Timer: uniquely identifies each Maintenance Timer. This has not to be confused with the 
Maintenance Timer identifier in Custom Logic. 

• Name: if required, type a short description for the timer in the Name column. 
• Set [Hours]: the number of hours (must be integer) for the first timer cycle. This can be helpful when 

you need to set a different timer for the first Maintenance cycle than for the subsequent cycles, 
otherwise it can be set at the same value as Reset [Hours]. 

• Reset [Hours]: the number of hours (must be integer) for all the subsequent Maintenance Timer 
cycles; this timer can be restarted by Custom logic (see the maintenance_example project in your 
examples folder). 

• Close: Click here to close the window. 
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3.3.23 Passwords 
 

Click on the Passwords icon to access the Password Settings window in which you can enter, using the  
Service Password box, the password which will be requested when accessing each of the two submenus 
contained in the Service menu, including Maintenance (containing maintenance timer information), for 
which the password set in the Maintenance Password item on eDASH will also be used. These 
submenus can be reached in different ways dependent on the device type: 
 
- on “Compact Cluster” and “SmartView” devices, keeping the UP and DOWN buttons pressed for 4 

seconds, within the first 10 seconds after turning the device on; 
- on “SlimTitan” devices, by performing a touch on the upper left corner of the display and right after that  

by performing another touch on the lower right corner of the display, within the first 2 seconds from the 
switching on the instrument. 

 
 

On SlimTitan devices, after touching the two mentioned areas, the password entry page is shown, here 
you can enter one of the passwords indicated in Password Settings, using the numeric keypad on the 
bottom of the screen: 
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After entering the password, if this corresponds to the Service password, you are shown the page for 
entering the new value to which you want to set the hour meter of the instrument: 
 
 

 
 
 
On this page you must enter the 7 digits that will make up the new hour meter value; for example, to bring 
it back to the value of 1.0 hours it is necessary to enter the digits 0000010 (the last digit always indicates 
the decimals). To initialize the hour meter, simply enter the sequence 0000000. 
At the end of the insertion, the message "Restart device" is displayed; you can now reboot your device: 
 
 

 
 
 



- 49 - 

eDASH3K User Manual 

 

 

 
If, on the other hand, the password entered is the Maintenance one, the user is presented with a page from 
which he can choose the Maintenance Identification (Id) to be reset, by touching the relevant number on 
the numeric keypad present at the bottom of the screen: 
 

 
 
 

Note that only the Maintenance IDs that have been completed in the appropriate window are visible (see 
paragraph 3.3.22). By touching the number corresponding to the chosen Maintenance Id, this is reset to its 
Reset (Hours) value and the word "OK" appears below the value, indicating that the instrument can now be 
restarted. 
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3.3.24 Buzzer 

Click on the Buzzer icon to open a window showing a list of the lamps to which operation of the 
audible signal is connected. 

 
 

The Buzzer is optional; therefore this option could be ineffective if your device is not equipped 
with a Buzzer. 

 
 

See heading 3.3.4 for details on how to bind Lamp and Buzzer. 
 

3.3.25 SplashScreen  

Click on the SplashScreen icon to open the Splash Screen set-up window, i.e. the window that is 
displayed during the instrument's power-up routine. 

 

 
• Click on the Background Color box to select the background colour. 
• Click on the Splash Screen Image box to select an image to be shown as background. 

 
 

 The size of the image to be inserted cannot exceed the size of the display. 
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The position and size of the image cannot be changed: the image is inserted automatically in the 
centre of the display, filling the screen in the case of large size images, or leaving a surrounding 
area of background colour in the case of smaller images. 

 
• Click on Reset to abandon the selected settings and restore the starting condition (Splash Screen 

disabled). 
• Click on the gear icon alongside no image to open the image compression window. 

 

• Click on the drop-down list alongside Exported Format to select the format in which to export the 
image. 

• In the Info box you can display the image dimensions (Image), the original file size (Original Size) 
and the size after the chosen compression type (Exported Size). 

• You can compare the effects of compression on the image in the Original Image and Export Preview 
windows.



- 52 - 

eDASH3K User Manual 

 

 

3.3.26 Translations  
 

 This function is available only for the “Slim Titan” Hardware Type.. 
 
By pressing the button marked with the Translations icon, you can access the page for inserting and editing 

the translations combined with the text elements present in the application, that is, the elements of Text 
type. 

 
The Translations page will show up in a similar manner to the example provided below: 
 

 
 
The two columns are always present and show the following information for each object of Text type: 
 

• Name: refers to the name of the object, as reported in the Name field of the related properties window. 
• Default Text: shows the original text to be displayed, as reported in the Text field of the related properties 

window. 
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The columns highlighted in grey are not editable from the Translations page; instead they can be 
modified directly from the relative property page as it normally happens for any other type of object. 

 
To add a translation (or, generally speaking, an alternative wording) to the existing texts, it is first necessary to 

define a name for the new language (i.e. the new set of texts) to be supported; to do this, press the "Add 
new language" button and type a name in the appropriate window: 

 

 
 
The name assigned to the new language can only contain letters and digits (the program automatically 

removes any unsupported characters that may have been entered). By pressing the OK button a new 
column is added to the Translations window, allowing you to populate it with the captions to be associated 
with each text, simply by clicking on the box corresponding to the translation to be entered: 

 

 
 
It is also possible to take advantage of the copy & paste features of the most common spreadsheets (Excel, 

OpenOffice Calc, etc.) by pasting the desired selection of cells directly on the appropriate grid box. In this 
way it is possible to write the translations in a separate file and then insert them in one go in the project. 

 

To take advantage of the copy & paste functionality of translations from a spreadsheet to the 
Translations window, you must ensure that there is perfect alignment between the translations and the 
wordings to be translated. eDASH3K will not check that the translation associated with a text is actually 
the translation of that text in a given language. 

 
 
Once the entry of the translations is satisfactory, you can confirm it by pressing the OK button; or you can add 

more new translation sets by pressing Add new language again, following the steps already described. 
To delete a whole translation set, simply select it by clicking on its column header and then press the Remove 

selected language button. 
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The maximum number of translation sets that can be supported is 8; however this value is dependent on 
the available memory and could therefore be lower than that. Projects with lower memory occupation on 
the Slim Titan device will be more likely to be able to handle the maximum number of translation sets. 

 
When the translation sets have been compiled, they can be recalled during the execution of the project on the 

device by means of a specific instruction to be included in Custom Logic. 
Typically, the designer will set up a Button object, upon pressing which he will call the appropriate 

set_current_edash_language() function specifying the index of the required language. The indexes for the 
languages are always numbered in ascending order starting from 0 (which is always reserved for the Default 
Text), following the order in which the translation sets appear in the Translations window. 

For example, consider the following case: 
 

 
 
In this case there will be the following combinations of translations set and Index: 
- Default Text:  Index 0 
- FR:  Index 1 
- DE:  Index 2 
 
For a detailed example of how to handle translations, please refer to the translations_example project available 

in the slimtitan section of the eDASH3K examples folder, accessible from Project → Examples… 
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4 Additional configuration procedures 
 

4.1 Display 
With regard to elements that can be inserted in the display, you are prompted to specify the user settings 
while inserting the element in question (see "Specific Commands"). If you want to change the chosen 
settings, point the mouse at the element in question and then right click to show the Tool Box on the right 
of the page, or left click to open the drop-down menu. 

 

In the Tool Box you can change all the previous settings while the drop-down menu provides 
access to only a limited number of settings. 

 
 
 

4.2 LED indicators and gauges 
 

This option is only available on “Compact Cluster” Hardware Type. 
 

During Compact Cluster configuration you can configure the LED indicators and gauges present in the 
dashboard. 

 

 

There are 11 LED indicators: 

• 
High Beam 
Lamp 

 

• 
Warning 
Lamp 

 

• 
Temperature 
Lamp 

 

• 
Low Beam 
Lamp 

 

• 
Parking Brake 
Lamp 

 

• 
Low Fuel 
Lamp 

 

• 
Turning Light 
Lamp 

 

• 
Engine Oil Pressure 
Lamp 

 

• 
Backlight 

 

• 
Preheat 
Lamp 

 

• 
Battery 
Lamp 

 

There are 3 gauges: 

 

• 
RPM 
Pointer • 

Fuel 
Pointer • 

Temperature 
Pointer 
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4.2.1 LED indicators 
 

All LED indicators, with the exception of the Warning Lamp (Compact Cluster only) and Battery Lamp 
(SmartView only), have the same set-up options, namely: 

• 
Name: If required, type the name of the indicator lamp in the field alongside Name. 

• 
Signal: clicking on the drop-down list alongside Signal you can associate an input (Pin), Can 
message (Can), special function (Special) or variable (Var) with the indicator lamp. 

• 
Test: click on the Test button to obtain a preview of the operation of the LED indicator. 

• 
Activate Warning Lamp: flagging the Activate Warning Lamp checkbox you can associate 
activation of the warning lamp with illumination of the LED indicator. 

 

This function is available only when the Is Alarm checkbox is flagged in the Warning Lamp 
configuration. 
The Activate Warning Lamp and Is Alarm functions are available only for the "Compact Cluster" 
Hardware Type. 

 

• 
Activate Buzzer: flag the Activate Buzzer checkbox to associate activation of the audible signal with 
illumination of the LED indicator. 

 
The Warning Lamp differs due to the possibility of setting up the function by means of the Is Alarm flag. 
When Is Alarm is not flagged, the Warning Lamp offers the following configuration options: 

• 
Name: If required, type the name of the LED indicator in the field alongside Name. 

• 
Signal: clicking on the drop-down list alongside Signal you can associate an input (Pin), Can 

message (Can), special function (Special) or variable (Var) with the LED indicator. 

• 
Test: click on the Test button to obtain a preview of the operation of the LED indicator. 

• 
Blink: flag the Blink box to activate warning lamp blinking mode. 
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• 
Activate Buzzer: flag the Activate Buzzer checkbox to associate activation of the audible signal with 

illumination of the LED indicator. 
 

Conversely, when Is Alarm is flagged the Warning Lamp has the following configuration options: 

• 
Name: If required, type the name of the LED indicator in the field alongside Name. 

• 
Test: click on the Test button to obtain a preview of the operation of the LED indicator. 

• 
Blink: the Blink box to activate warning lamp blinking mode.. 

 
Activating the Is Alarm function also displays, in the field below Alarm activator lamps, a list of the LED 
indicators with which operation of the warning lamp has been associated. 
 

In this mode, the Warning Lamp lights only on activation of at least one of the LED indicators  
associated with it. 

 

4.2.2 Gauges 
 

All gauges feature the same setting options, namely: 

 

• 
Name: if required, type the name of the gauge in the field alongside Name. 

• 
Signal: click the drop-down list alongside Signal to associate an input (Pin), Can message (Can), 

special function (Special) or variable (Var) with the gauge. 

• 
Test: click the Test button to obtain a preview of the operation of the gauge. 
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4.3 Signal function 
 
Setting a Signal provides access to a series of further configurations. 
 
In Lamp and LED indicator settings: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 

Binding Additional settings 

 

Pin (DIGITAL) 

• Blink: activation/deactivation of indicator blinking (if on). 
• Active: indicator activation mode (High if indicator switches on when input is high 

or Low if indicator switches on when input is low). 

 
Pin 
(ANALOG / 
FREQUENCY) 

• Blink: activation/deactivation of indicator lamp blinking (if on). 

• Threshold: indicator lamp activation threshold setting. 

• Tolerance: threshold value tolerance setting. 

• Active: indicator lamp activation mode setting, with values below or above the 
threshold value. 

 

 
Can 

• Blink: activation/deactivation of indicator lamp blinking (if on). 

• Threshold: indicator lamp activation threshold setting. 

• Tolerance: threshold value tolerance setting. 

• Active: indicator lamp activation mode setting, with values below or above the 
threshold value.. 

 
 

Special 

• Blink: activation/deactivation of indicator lamp blinking (if on). 
• Threshold: sets the warning light activation threshold. 
• Tolerance: sets the tolerance for the activation threshold. 
• Active: indicator light activation mode setting (High if indicator switches on when input 

is high logical level or Low if indicator switches on when input is low logical level). 

 

 
Var 

• Blink: activation/deactivation of indicator lamp blinking (if on). 
• Threshold: indicator lamp activation threshold setting. 
• Tolerance: threshold value tolerance setting. 
• Active: indicator lamp activation mode setting, with values below or above the 

threshold value. 
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In BarGraph configuration: 
 

Binding Additional settings 

Pin • Associate the bar with a physical input. 

Can • Associate the bar with a CAN message. 

Var • Associate the bar with a variable 

Special • Associate the bar with a special function 

 
In Pointer configuration: 

 

Binding Additional settings 

Pin • Associate rotation with a physical input. 

Can • Associate rotation with a CAN message. 

Var • Associate rotation with a variable. 

Special • Associate rotation with a special function. 

 
In Gauges: configuration: 

 

Binding Additional settings 

Pin • Associate rotation with a physical input. 

Can • Associate rotation with a CAN message. 

Special • Associate rotation with a variable. 

Var • Associate rotation with a special function. 
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4.3.1 Special Functions 
 
There are three Special functions that can be associated with the components: Total Hour Meter, DTC Error 

and Alternator (SmartView only). 
 
• Total Hour Meter is the special function usually associated with a “Numeric” object which shows the 

number of hours the vehicle has operated. This function uses an hour meter inside the instrument (for 
further information see subheading 3.3.10). 

 
• Total Hour Meter CAN is the special function usually associated with a “Numeric” object which shows 

the number of hours the vehicle has operated. This function uses the hour meter sent by the engine on 
the CAN line (for further information see SAE J1939-71, SPN 247). The amount of hours is represented 
in hundredths of an hour, increased by steps of 5 hundredths each. 

 
• DTC Error is the special function of the CAN BUS line and it is usually associated with a physical 

indicator lamp or a display indicator lamp. This function acts by making the indicator switch on in the 
presence of DM1 type Diagnostic Trouble Codes (DCT) on the CAN line (for more information refer to 
standard SAE J1939). Press the "arrow up" button for 4 seconds ("Compact Cluster" hardware) or the 
indicator itself ("Slim Titan" hardware) to open the page containing a list of all the DTCs being received 
on the CAN line. To quit the above page press the "arrow up" button again for 4 seconds ("Compact 
Cluster" hardware) or a random point of the display ("Slim Titan" hardware). 

 
• Alternator is the function that sets battery warning light and alternator excitation current management 

automatically. This function should normally be linked to the battery warning light. If this special function 
is used SmartView PINS 12 and 25 must be connected to the alternator D+ signal. 

 
 

Alternator is available on “Smartview” only. 

 
• Battery Voltage is the special function usually associated with a “Numeric” object which shows the battery 

voltage. 

 

• Maintenance N this special function can be associated with an indicator lamp or a “Numeric” object for 

displaying the state of the maintenance hour meter. If associated with a “Numeric” object the time 

remaining on the hour meter will be displayed (the number is displayed in tenths of an hour). Correctly 

format the display field (add a decimal point or divide by 10 using the coefficients A, B and C). If associated 

with an indicator lamp, the indicator lamp will be set to the ON status if the associated hour meter reaches 

zero (maintenance due). 

 

• Maintenance All this function may be associated with an indicator lamp. The indicator lamp will be set to 

the ON status if at least one of the eight maintenance hour meters reaches zero (maintenance due). 
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5 Device Connection 
 

5.1 Setting up the USB-CAN Converter 
 
In order to successfully use the device with a PC it’s essential to install the control software (driver) for the 

USB-CAN converter, which can be downloaded directly by entering the following address in your internet 
browser: 

 
https://www.peak-system.com/quick/DrvSetup 
 
Alternatively you can open the manufacturer's website www.peak-system.com and then click on Support and 

then on the Download button relative to the "Device driver setup for Windows" item: 

 

 

 

 

At the end of the download the file PEAK-System_Driver-Setup.zip will be downloaded: 

 

Click on the file with the right mouse button and select the option "Extract files in PEAK-System_Driver-
Setup", so as to produce the respective folder containing the converter control software: 

 

 

Run the PeakOemDrv.exe program, located inside the folder; it will automatically start the installation of 
the latest version of the converter control software and the support applications (useful for any 
connection diagnostic sessions). 

Depending on the security settings, this screen could appear: 
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If so, press "Run" to continue; the following window appears: 

 

 

 

Press "Next" to continue; the following window appears: 
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Click on the option "I accept the terms in the License Agreement" and press "Next" to continue; the 
following window will appear: 

 

 

In this screen it is necessary to select all the components, in order to perform a complete installation of 
the package. If any component is not enabled (i.e. it shows a red "X" icon alongside its name) simply 
click on it and select the option "Entire feature will be installed on local hard drive".  

The window with all the enabled components looks like this: 
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Press “Next” to continue: 

 

 

Press "Install" to actually start the installation. At the end of the operation the window that signals the 
success of the operation appears. Press "Finish" to finish the procedure. 
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At this point it is possible to connect the PEAK converter to the PC on any USB port; the other end must be 

connected to the programming cable (universal plug): 
 
AM.148.1        CABL. BASE X PROGR. STRUMENTI 
 
which in turn must be connected to the device by means of the relevant cable (specific for each device):  
 
AM.148.2        CABL.PROGR.SMARTVIEW 
AM.148.5        CABL.PROGR.CCLUSTER           
AM.148.8        CABL.PROGR.SLIMTITAN  
 
To ensure that the connection is correctly done, it is possible to access the "Device Management" application 

in Windows and check that the "CAN-Hardware" section is present and that the "PCAN-USB" entry is 
contained in it: 

 

 
 

 If the "CAN-Hardware" section is missing, it means that the driver installation was not successful; 
repeat the procedure described above, making sure to obtain a successful outcome; 

 If the "CAN-Hardware" section is present, but the "PCAN-USB" element does not appear inside it, 
it means that the drivers have been installed correctly, but the physical connection is apparently 
missing: check that the converter ends are firmly connected, possibly trying to connect it to a 
different USB port on the PC. 
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5.2 Compact Cluster 
 

To connect the instrument to the PC plug the blue connector into the blue socket. The pins are numbered from 
1 to 5, from the left. PIN 1 carries the CAN_L signal and PIN 4 carries the CAN_H signal. 

 
Connect the metal connector to the other socket (red): 
 

 24 pins: PIN 5 is +Vcc and PIN 12 is GND; 

 36 pins: PIN 9 is +Vcc and PIN 16 is GND. 
 

 
 

5.3 SmartView 
 

To connect the instrument to the PC the pinout is: 
 

 PIN 1: +Vcc; 

 PIN 2: +Vcc; 

 PIN 3: GND; 

 PIN 4: GND; 

 PIN 19: CAN_L; 

 PIN 20: CAN_H. 
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5.4 SlimTitan 
 
To connect the device to the PC the pinout is: 
 

 PIN 1: +Vcc; 

 PIN 2: +Vcc; 

 PIN 3: GND; 

 PIN 4: CAN_H; 

 PIN 5: CAN_L. 
 



- 68 - 

eDASH3K User Manual 

 

 

6 Advanced Settings 
 
This chapter describes how to use the additional functions which are not configurable via the eDASH3K 

graphic interface but only by directly accessing the instrument's source code via the API provided by AMA. 
For the use of these functions it is necessary to install all the components which are listed during eDASH3K 

installation. 
 

 
 

6.1 Installing Software for Advanced Settings 
 
To select the desired tool, simply click on its checkbox. 
 

6.1.1 Notepad++ Editor 
 
Installs the Notepad ++ 6.9.2 text editor for inserting the instructions in C / C ++ language to define the custom 

device logic (see the following paragraphs). 
 

6.1.2 Toolchain for SlimTitan 
 
Check the option gcc-arm-none-eabi-4_9-2014q4 for SlimTitan. This is the required package to merge 

custom logic into SlimTitan device firmware. 
 

6.1.3 Toolchain for Compact Cluster and SmartView 
 
Check the option Softune for Compact Cluster and SmartView. This is the required package to merge 

custom logic into Compact Cluster and SmartView device firmware. 
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6.2 Edit Custom Logic  and Custom Logic Help 
 
After installing every program, click on the Edit Custom Logic icon to access the device's source code. 
A text file is presented which the user must fill in using Notepad++ 6.9.2. software. 
This is the file which must be edited to customize the device by adding logic functions and/or calls to the APIs, 

using the programming language C/C++. 
 
Click on the Custom Logic Help icon to access the list of all the APIs which are made available for 

customizing the device. 
 

The GR_HANDLE type is the name of the objects created in eDASH3K. Replace the ‘ ’ (space) 
character in the object names with the ‘_’ (underscore) character. 

 
 

6.3 Compiling the Source Code 
 
Click on the Run On Device icon to compile the code. 
If no errors are detected then the device will be reprogrammed with the customized software and with the 

graphic objects added in the eDASH3K project. 
If any error is detected, it will be displayed in the dialogue window and the process will be aborted without 

updating the device. 
 

Holding down the SHIFT key on the keyboard while clicking on the Run On Device icon in 
eDASH3K, you can download the application software only, without the graphic objects of the 
eDASH3K project (this procedure is useful when you are modifying the source code only and 
you don’t need to download the same graphic objects every time). 

 
  



- 70 - 

eDASH3K User Manual 

 

 

7 Optimizing memory occupation 
 
When developing applications with eDASH3K, especially for devices that have larger screens such as the Slim 

Titan, the hurdle of the maximum memory limit of the device may arise. 
This chapter will present some simple techniques and strategies which, when applied in the appropriate 

scenarios, can allow the designer to make more efficient use of the available memory, while maintaining a 
satisfactory quality standard of the application. 

 
 

7.1 Basics of memory management 
 
It is useful to know that the images inserted within a project are encoded with two possible formats: 
- RGB 565 (for background images, only on devices which support this feature) 
- ARGB 4444 (for every other type of object) 
 
The RGB 565 format uses 16 bits distributing them on the three colour components Red, Green, Blue, without 

transparency which would be pointless on the backgrounds since there wouldn’t be any further underlying 
layer below them. When applied to Backgrounds it guarantees a better graphic rendering at the price of a 
slightly higher weight of the relative bitmap. 

Conversely, the ARGB 4444 format favours a lower weight of the image in terms of memory room occupation, 
using 12 bits for the three colour components and 4 to handle transparency. 

These notions can be important in the production of images for background, lamp and customized buttons: by 
appropriately configuring the most common graphics programs it is possible to reduce the difference in look 
between the images produced in Windows (which are typically 24 bits) with those which drawn on the 
instrument display (16 bits as previously described); in fact, in order to be processed and drawn on the 
display, images natively created in 24 bits must be converted into the appropriate 16 bits format by 
eDASH3K, which is then forced to reduce the number of colour shades actually used, with possible 
consequences on the final result. 

 
 

7.1.1 Memory performances 
 
 

At this revision, this paragraph relates solely to the "Slim Titan" Hardware Type. 
 
 
An important aspect to keep in mind when evaluating the memory occupation of your project is related to the 

performance of the memory itself. 
In fact, depending on the hardware type, it is possible that a part of the total memory area has different 

performances, for example because it is external to the central processor of the device. This normally does 
not involve any operational difference, but in the case of graphic elements that have a large memory 
occupation it can give rise to slowdowns in the execution of the application, when these elements are 
transferred from memory to the CPU. 

To take care of this possibility, eDASH3K automatically reserves room for background images, typically 
heavier than other graphic elements, in the fastest available memory until there is enough space, after which 
it produces an error message if any background images were to exceed its limits. If the background images 
do not exceed the limits of the internal memory, this is used as far as possible also for the other types of 
elements, after which eDASH3K makes use of any external memory area. 
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As previously mentioned, there is no functional difference for a Button whose image resides in one or the other 
of the memory areas, as long as its memory occupation remains at normal levels, for example like it is with 
the graphics elements provided with eDASH3K. However, when adding graphic elements of your own 
production it is always advisable to keep the memory occupation of the images as low as possible: this 
generally should not provide an issue, as the total size of a Button or a Lamp of 100 x 100 pixels, even with 
shadings and transparencies, should not need exceeding a value of 30-35KB in the Navigation Tree.  

Such a size allows to easily handle the object regardless of its placement in any type of memory. On the other 
hand, a significant overcoming of this size, in a project large enough to bring it to be placed in the external 
memory, can cause slowdowns of the application during use. 

 
 

7.2 How to reduce the amount  of occupied memory 
 
In the following paragraphs we will see how to keep memory occupation under control in order to ease most of 

the aforementioned issues. 
 
 

7.2.1 Monitoring occupied memory 
 
Each Hardware Type has a different amount of available memory, which is indicated in the title bar of 

eDASH3K, together with the space occupied so far, also expressed as a percentage: 
 

 
 

To optimize memory occupation, eDASH3K uses some precautions, in particular RLE compression (described 
in the following paragraph) and the reuse of duplicate images: every time the user modifies the project by 
adding, deleting or replacing an image, be it part of a Button, a Lamp, etc., eDASH3K analyses the current 
state of the application to identify any graphic elements which is used more than once, and in this case 
takes advantage of it reserving memory occupation equal to 0B (0 bytes) for the copies. 

Basically therefore by reusing the same graphic elements where possible, for example for the background of 
the pages or for the Buttons, the user can save a significant amount of memory. Obviously this is not always 
possible, but it is important to take this opportunity into account where the size of the project becomes large. 

The analysis of the current state of the application is always performed in the direction of processing the 
current page last: it may therefore happen that the weight of the memory occupation of a certain image, for 
example associated with two different Lamps, is move from one to the other in the face of processing. 

This is absolutely normal and does not involve any type of effect for the purpose of the application's operation. 
 
 

7.2.2 Compressing images 
 
Both formats described so far have the possibility of being compressed with RLE encoding. The saving in the 

final image size depends on its complexity: RLE compression is very effective on portions of uniform colour, 
so the result can vary between a maximum compression result on a monochrome image to a minimum 
compression result on an image where each pixel has a different colour than the surrounding pixels. 

RLE compression is always proposed as default when adding a graphic object to the project; it is advisable to 
keep it enabled at all times to ensure that you save as much memory as possible with the same graphic 
elements. 
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7.2.3 Choosing fonts wisely 
 
Every time you add a text element to the project, be it a number, a real text, an HourMeter or a DateTime, a 

font is selected for that element, and a portion of memory is reserved for that type of font. This portion of 
memory will generally be proportional to the font size. 

As for images, the reuse of the same font for multiple alphanumeric elements does not involve an increase in 
memory occupation, therefore to reduce the overall occupation of the project it can be very useful to make 
the choice of fonts more homogeneous, limiting the use of dimensions. and / or different styles. 

 
 

7.2.4 Alternatives for texts 
 
Starting from version 1.11.7, the set_label_text() function is available which allows you to change the 

content of a Text while the application is running. This solution can be particularly beneficial in terms of 
memory occupation for those previously implemented projects where text messages were made using 
images containing text. In fact, the memory occupation of a certain number of these images could be much 
higher than the memory occupation of a single font. 

Indeed, if the font used were already present, the memory occupation would go from the total occupied by the 
various images to zero, with a considerable advantage for the project. 

Also worth mentioning is the presence of the set_edash_font_color() function which allows you to 
change the colour of a Text or Numeric during execution. Also in this case the elimination of numerous 
images with text of different colours, in the face of the use of a font, can be very advantageous. 

 
A case in which the opposite may be advisable is the need to display a static wording with a very large font, for 

example in a welcome page or in a page called up to show a fixed message; in such circumstances, the 
weight of a very large font not used elsewhere could justify the replacement of the Text with Graphic objects 
produced through drawing tools and containing the text to be displayed, suitably formatted according to the 
desired requirements. 

Given that the memory occupation of a font depends on the style, size and type of font, while the occupation of 
any self-produced Graphic object may depend on the format, colours, dimensions, etc. the choice between 
these two solutions must be evaluated by the user on a case-by-case basis. 

 
 

7.2.5 Buttons on Background 
 
In very specific situations, in which it is necessary to use a Button with a significant memory occupation in a 

project which is very large, a possible way out is provided by the possibility of directly merging the pictures 
of the Buttons on the Background image of the page and to use transparent Buttons; that is, Buttons not 
having any Released or Pressed image. 

To remove the pictures from a Button, simply use the Drop Image button which is located next to each of the 
two pictures that can be associated with a Button. The user must then place the transparent Button in the 
desired position on the display, making sure to match the position of the merged picture on the Background. 

The touch area of the Button will still work, as it’s not necessary to have any pictures in a button for it to work, 
and the user can change its size by means of the values indicated in the Touch Width and Touch Height 
boxes: 
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This solution has pros and cons that must be evaluated by the user based on the project requirements: 
 

PROS 
- All the amount of graphic memory occupied by the Buttons involved would be released; 
- Since the Buttons become an integral part of the Background, which occupies memory anyway itself, their 

pictures could now be refined as much as needed; 
- Since the Background uses a different and less compressed graphic format (see par. 7.1), the visual 

appearance of the Button picture could result even improved compared to the same picture when applied 
on Buttons. 
 
CONS 

- As each Button would now have only one picture instead of two, it becomes impossible to set a different 
image for press and release events; 

- Having Buttons merged into the Background, the task of making changes to the page layout could become 
a bit more bothersome, because placing a specific Button elsewhere would now involve changing the 
Background in addition to moving the transparent button. 

 
 

7.2.6 Disable UART functionalities (Smart View only) 
 
You can disable the UART port functionalities, setting free a small amount of memory for custom logic use. For 

further details please see “3.3.19 Hardware”. 
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APPENDIX 
 

A Basics on Custom Logic 
 
Below are some of the most common concepts and applications of the Edit Custom Logic command 

previously described. 
 

The text file that appears by pressing Edit Custom Logic is divided into different functions, each 
preceded by some notes that describe its role; it is important to read these notes to understand 
where it is most appropriate to insert your own custom logic instructions. In most cases the most 
suitable function for adding instructions is custom_logic_tick_100ms(); in the examples shown 
below it is always considered that the code is introduced in this function. When using several 
functions, always keep in mind the different timings of the functions themselves. 

 
 

A.1 How to Refer to an Element of the Project 
 
Generally speaking, all the objects in the project (including the pages that make up the project) are identified by 

the name that was assigned to them in the appropriate box on the Properties Panel (F). The same name is 
used to refer to a specific object when you are developing your custom logic. 

However, depending on the API you are using, there are two ways to refer to a project element in the code: 
 

 When the API requires a parameter of GR_HANDLE type, you must use the same name that was 
assigned to the object in the project: 

 

       
 

 When the required parameter is of integer type, the relevant constant must be used; the name of this 
constant is normally composed by adding the text T_KEY_ at the top of the name of the object: 
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A.2 How to Show/Hide an Element 
 
An element present in the project is normally always visible except in the following conditions: 
 

 It is on a different page than the one currently displayed. 

 It is on the current page but the Hide on startup property has been set, therefore the object is kept 
hidden when the project starts. 

 
You can alter this logic using the set_item_visible() command, as shown in the following example: 
 
set_item_visible(button_off, false); 

 
In this case the visibility status of the button_off object is changed, making it hidden by means of the second 

parameter false. To make it visible again, simply repeat the same command, assigning the second 
parameter the true value. 

 
set_item_visible(button_off, true); 

 
 

A.3 How to Assign a Value to a Variable 
 
If a variable has been added to the project (see heading 3.3.21) it is possible to modify its value by means of 

the command set_edash_var_value(), as shown in the following example: 
 
set_edash_var_value(myVariable, 99); 

 
This command needs two parameters: 

 The name of the variable to which you want to assign a value (it is the name that has been given to the 
variable during its definition), in this case myVariable: 

 
 

 The value to be assigned to the variable, in this case 99 (but it can be any valid C / C ++ expression 
that returns a value) 
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A.4 How to Handle Button press 
 
If any custom logic must be executed when a button is pressed, it is possible to catch the condition using the 

is_key_clicked() function; the following example demonstrates how to use it to set to zero the value of a 
variable when a button is pushed by the user: 

 
boolean_t button_off_status; 
is_key_clicked(T_KEY_button_off, &button_off_status); 
if (button_off_status) { 

set_edash_var_value(myVariable, 0); 
} 

 
The is_key_clicked() function requires two parameters: 
 

 An integer type value corresponding to the button identifier whose press is to be recognized, in this 
case T_KEY_button_off. 

 A variable of boolean_t type (in the example it has been declared in the first line of code) which will 
assume value true or false depending on whether the button has been pressed or not. 

 
In the example, when button_off_status is true it means that the button_off button has been pressed, and 

consequently the value 0 is assigned to the variable myVariable. 
 
It is also possible to catch the time length of the pressure applied to a button, for example to manage functions 

that must be activated by keeping a button pressed for a certain period of time. In cases like this it is 
possible to recall the value contained in the userKeyPressed[] data structure, an array containing, for each 
button, the time elapsed since the last change of state of the button. The value is expressed in tenths of a 
second. 

 
static uint32_t u32time_Key_Pressing_ENTER = 0; 
if(userKeyStatus[T_KEY_button_ENTER]) { 
    u32time_Key_Pressing_ENTER = userKeyPressed[T_KEY_button_ENTER]; 
} 
else {   
    u32time_Key_Pressing_ENTER = 0; 
} 

  
In this example a variable named u32time_Key_Pressing_ENTER is declared and initialized to 0; 

subsequently, the relevant value of the array userKeyStatus[] is read, using T_KEY_button_ENTER as the 
identifier of the button. In userKeyStatus[] the current state of a given button is stored for each position of 
the array; if this is true then the button is pressed and therefore the example reads the time from when the 
button entered this state from the userKeyPressed[] array and stores it into u32time_Key_Pressing_ENTER. 

Otherwise if the current state of the button is false then the variable is simply set to zero once again. 
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A.5 How to Open a Specific Page 
 
It is always possible to obtain the name of the page currently displayed by means of the function 

get_current_edash_page() which does not need any parameter and returns a variable of type GR_HANDLE 
associated with the page; for example for the default page the GR_HANDLE will always be Main_View (see 
the note at heading 6.2). 

Likewise, if the project contains multiple pages, it is possible to call up a specific page using the 
set_current_edash_page() function which requires a single parameter, the GR_HANDLE of the page to be 
called. 

The following example shows how to call up a page at the press of a button: 
 
GR_HANDLE currentPage; 
boolean_t button_next_status; 
 
currentPage = get_current_edash_page(); 
is_key_clicked(T_KEY_button_next, &button_next_status); 
if (button_next_status) { 
    if (currentPage == Main_View) { 
        set_current_edash_page(Page_1); 

 } 
} 
 

In the example, the value of the current page is stored in the currentPage variable; subsequently, if the button 
has been pressed, the function set_current_edash_page() is called, passing as a parameter the 
GR_HANDLE of the page to be displayed. 

Before displaying the page, the value of the current page is tested since the page to be displayed depends on 
the one it came from. 
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A.6 How to Edit a DateTime Object 
 
When adding a Time or Data item, it could be useful to allow editing of the displayed date and / or time, so that 

the user can easily set them if necessary. 
Several functions are available that allow you to interact with a DateTime object, as demonstrated by the 

following example, where the user is given the options to set a Time object called HH_MM: 
 
boolean_t bKeyStart_status = false; 
boolean_t bKeyUp_status = false; 
boolean_t bKeyDown_status = false; 
boolean_t bKeyNext_status = false; 
boolean_t bKeyFinish_status = false; 
 
is_key_clicked(T_KEY_button_START, &bKeyStart_status); 
is_key_clicked(T_KEY_button_UP, &bKeyUp_status); 
is_key_clicked(T_KEY_button_DOWN, &bKeyDown_status); 
is_key_clicked(T_KEY_button_NEXT, &bKeyNext_status); 
is_key_clicked(T_KEY_button_FINISH, &bKeyFinish_status); 
if(bKeyStart_status) { 
    clock_editing_start(HH_MM); 
} 
if(bKeyUp_status) { 
    clock_editing_up(HH_MM); 
} 
if(bKeyDown_status) { 
    clock_editing_down(HH_MM); 
} 
If(bKeyNext_status) { 
    clock_editing_next(HH_MM); 
} 
if(bKeyFinish_status) { 
    clock_editing_finish(HH_MM); 
} 
 

All functions act on the DateTime object whose GR_HANDLE is passed as a parameter. 
When the button_START button is pressed, the clock_editing_start() function is called to enable the 

modification of the numerical value displayed. Visually you notice that the hours value starts to flash. 
Pressing the buttons button_UP and button_DOWN the clock_editing_up() and clock_editing_down() functions 

are called respectively, which alter the value increasing or decreasing it, respectively. 
Since a DateTime object can have 2 to 3 numeric elements depending on the format, it is possible to switch 

between the various elements cyclically using the function clock_editing_next(). 
Finally with the function clock_editing_finish() the modification of the numerical value is ended. 
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A.7 Debug through Serial Port 
 
During the development of custom source code it could happen to insert instructions that, even if they are 

formally correct, contain errors of logic and therefore put the device in an unstable state or in any case not 
coherent with what is wanted. 

A possible way to identify and correct these situations is to debug them through the serial port: basically it is a 
matter of inserting specific instructions in appropriate points of the code which send to the serial port the 
content of the variables that are supplied as parameter, allowing for example to recognize and monitor any 
unpredicted status changes in the variables in question. 

There are two functions available for reaching this goal: 
 

 For Slim Titan devices, the function is logserial() 

 For “Smartview” and “Compact Cluster” devices, the function is logstring() 
 
The following examples show how to send a text message with some variables’ values to the serial port: 
 
Example of use of logserial function (Slim Titan device) 
bkey_Status = false; 
is_key_clicked(T_KEY_button_UP, &bkey_Status); 
logserial(“Valore di bkey_Status: %d”, bkey_Status); 
if(bkey_Status) { 
    clock_editing_up(HH_MM_SS); 
} 

 
In the example we assume that we want to monitor the value of the variable bkey_Status, so as to discriminate 

whether the behaviour of the subsequent if… then structure is actually the one expected. 
Two parameters are passed to the logserial() function: 
 

 A text string with the message you want to send on the serial port. 

 The name of the variable whose value must be included in the text string 
 
The logserial() function therefore has the same behaviour as the fprintf() function of C language. 
The text string contains the format specifier %d which tells the logserial() function that it must be replaced with 

the value of the integer type variable supplied later as a parameter. 
It is possible to insert different format specifiers in the text string, as long as an expression (variable or explicit 

value) is subsequently provided for each of them. Each value supplied as a parameter must as always be 
separated by a comma. 

 
The format specifiers to be used are different depending on the type of variable to be replaced, here are the 

most commonly used in debugging operations: 
 

 %d = int type variable 

 %c = char type variable 

 %f = float type variable 

 %s = char* (string) type variable 
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Example of use of logstring function (Compact Cluster/Smartview device) 
bkey_Status = false; 
is_key_clicked(T_KEY_button_UP, &bkey_Status); 
char buf[20]; 
uint8_to_str(buf, 20, bkey_Status); 
logstring(“bkey_Status value: ”); 
logstring(buf); 
if(bkey_Status) { 
    clock_editing_up(HH_MM_SS); 
} 

 
The logstring() function, on the other hand, is used differently because it accepts only one argument of type 

string (array of characters). For this reason, if you want to have them represent numeric values as in this 
case, it is first necessary to convert the value into text using one of the appropriate conversion functions, 
listed in the following table. 

 
Function name Type of numerical value to be converted 
int8_to_str Signed 8 bit integer 
uint8_to_str Unsigned 8 bit integer 
int16_to_str Signed 16 bit integer 
uint16_to_str Unsigned 16 bit integer 
int32_to_str Signed 32 bit integer 
uint32_to_str Unsigned 32 bit integer 

 
For more details about conversion functions see the help file by pressing the Custom Logic Help button. 

 
To examine the output sent to the serial port, it is necessary to connect the PC to the device via the serial port 

(in addition to the connection via CAN) and set up a terminal emulator on your PC in order to query the data 
on the serial port (for example RealTerm , TeraTerm, etc.) and configure it appropriately. 

Below is an example applied to the TeraTerm program, configured to access serial port 21: 
 

 
 
 

Normally devices in standard configuration are not equipped with the serial port; to be able to put 
into practice the indications presented here it is therefore necessary to request an Evaluation 
Board of the specific device, which instead is provided with this connection equipment. 
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A.8 How to read data from UART channel 
 
In addition to being able to use the connection via serial port for debugging purposes, it is also possible to 

intercept data transmitted on it to the device. 
This is possible by introducing appropriate code in the predefined uart_receive() function, available in custom 

logic, where further details regarding its operation are also available. 
This function receives as input parameter a variable called data, of type uint8_t* (pointer to 8 bit integer without 

sign) which contains the content (payload) of the received message, with a size equal to 8 bytes. 
It is also possible to modify the configuration settings of the serial connection on which the message is to be 

received, using the uart_setting() function, described in Custom Logic Help 
 

This functionality is available only on SlimTitan and SmartView hardware. 
 
 
 

A.9 Get the reference of a graphic object 
 
If necessary, it is always possible to obtain the reference in the source code (GR_Handle) of a graphic element 

of the project. 
 
GR_HANDLE myHandle; 
boolean_t myResult; 
myResult = get_edash_item_handle(“gr_object_name”, &myHandle); 

 
The name of the object ("gr_object_name") is the text string with the name that was assigned during the design 

phase; for example, in the following image, it is bargraph_86: 
 

 
 
So referring to the example above, to obtain a GR_Handle of this object and store it in myHandle variable, just 

use the following command: 
 
myResult = get_edash_item_handle(“bargraph_86”, &myHandle); 

 
Once the GR_Handle is obtained, it is possible to use it freely in any function that accepts it as an input 

parameter. 
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A.10 Get system date and time in custom code 
 
DateTime type objects allow the operator to view (and possibly modify) the system date and time, however in 

some cased it may be necessary and/or useful to get the same information while processing custom code. 
The following example shows how to fill a clock_data_struct object with the values of year, month, day, hours, 

minutes, seconds taken from the system clock, and then to use it to show them in specific variables: 
 
clock_data_struct* myDateTime = 0; 
boolean_t btnRefresh_status = false; 
  
is_key_clicked(T_KEY_btnRefresh, &btnRefresh_status); 
if (btnRefresh_status) { 

RTC_get(myDateTime); 
set_edash_var_value(var_0, myDateTime->year); 
set_edash_var_value(var_1, myDateTime->month); 
set_edash_var_value(var_2, myDateTime->day); 

 set_edash_var_value(var_3, myDateTime->hour); 
 set_edash_var_value(var_4, myDateTime->minute); 
 set_edash_var_value(var_5, myDateTime->second); 
} 
 

Note that there is no possibility to set the date and time via code: this opportunity is deliberately reserved for 
DateTime objects, given that changing the date / time without it being represented on the screen would not 
be significant. 

 
 

A.11 How to manipulate the content of a Text element 
 
Text objects provide functions that allow you to fetch and modify the text they contain even while the program 

is running. 
 

This functionality is only available on SlimTitan hardware. 
 
 
The following example shows how to store the content of a text object called text_1 in a variable, and then how 

to modify its content with a modified text: 
 
char* oldString, newString; 
 
oldString = get_label_text(text_1); 
newString = “Sample Text”; 
set_label_text(text_1, newString); 
 

If you want to completely delete the contents of a Text object, there are two possibilities: 
- Assign the text string " " to the object (i.e. with at least one space character); 
- Make the object invisible by means of the set_item_visible() function. 
 

When using special characters in custom logic make sure that Notepad++ format is set properly by 
opening the Format menu and choosing the ANSI option. 
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A.12 Using OSD functions 
 

OSD management features are available only on the SlimTitan device. 
 

The camera_activate() function allows you to switch the instrument display between the standard display and 
the camera. It is possible to superimpose text and icons on the image captured by the camera, using the 
OSD (on screen display) functions. 

In order to take advantage of these features, it is first necessary to setup the area of the display that is meant 
to for showing the superimposed information: 

 
osd_windows_setup(TOP_HORIZONTAL, 20, ZOOM_x2, OSD_WHITE, TRANSPARENT); 

 
The osd_windows_setup() function requires 5 parameters by means of which it is possible to define, 

respectively: 
- The display portion of the screen reserved for the overlaying (choosing from the 4 predefined options); 
- The distance in pixels of the area with respect to the closest edge; 
- The magnification factor of the overlay content (4 predefined options from x1 to x4); 
- The background colour of the overlay (if not transparent); 
- The transparency level of the overlay background. 
 
The available options for each parameter can be found by opening the Custom Logic Help page in eDASH. 
It is not necessary to call the function at each application cycle, but only once (for example during initialization); 

obviously it will be required to use it again in the case the user wishes to change one or more parameters. 
Once the area intended for the overlay has been defined, it is possible to display graphic or text elements 

inside it: 
 
osd_enable_icon(TOP_HORIZONTAL, 4, osd_warning_triangle, OSD_RED, true); 
osd_set_text(TOP_HORIZONTAL, 8, "SAMPLE", OSD_YELLOW, false); 
osd_enable_icon(TOP_HORIZONTAL, 18, osd_warning_orange, OSD_WHITE, false); 

 
The example shows how to add respectively: 
- A flashing red icon with the danger symbol (triangle with exclamation point); 
- The word "SAMPLE" painted in yellow; 
- An orange icon with the danger symbol (orange triangle with exclamation point). 
 
Again, available options for the parameters (available colours, icons, etc.) are documented in the Custom Logic 

Help page in eDASH. 
 
If you want to hide an icon, simply call up the appropriate function: 
 
osd_disable_icon(TOP_HORIZONTAL, 4, osd_warning_triangle); 
osd_disable_icon(TOP_HORIZONTAL, 18, osd_warning_orange); 

 
For icons the user just needs to select the area, position and type of icon he wishes to hide. 
If, on the other hand, the user wants to hide a text, he must necessarily call the osd_set_text() function again, 

taking care to provide a text string with as many spaces as there are characters in the text to be hidden; 
referring to the example shown above: 

 
osd_set_text(TOP_HORIZONTAL, 8, "      ", OSD_YELLOW, false); 
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For a more detailed description of the available icons, please refer to the appropriate section of this manual. 
 

Description Icon Colour is changeable 
osd_engine_oil_pressure_low 

 
Yes 

osd_engine_coolant_level_low 
 

Yes 

osd_engine_oil_level_low 
 

Yes 

osd_braking_system_fault 
 

Yes 

osd_parking_brake 
 

Yes 

osd_battery_charge 
 

Yes 

osd_engine_air_filter_dirty 
 

Yes 

osd_hydraulic_oil_level_low 
 

Yes 

osd_hydraulic_oil_filter_dirty 
 

Yes 

osd_emergency_pressed 
 

Yes 

osd_engine_amber_warning_or_red_stop_lamp 
 Yes 

osd_engine_preheating 
 

Yes 

osd_enable_speaker 
 

Yes 

osd_disable_speaker  
 

Yes 

osd_left_arrow 
 

Yes 

osd_right_arrow 

 

Yes 

osd_up_arrow  Yes 
osd_down_arrow 

 Yes 

osd_videocamera_left 
 

Yes 

osd_videocamera_right 
 Yes 

osd_engine_MIL_lamp 
 Yes 

osd_hydraulic_oil_temperature_high 
 

Yes 

osd_engine_oil_filter_dirty 
 

Yes 

osd_fuel_level_low  Yes 
osd_load_tipping 

 
Yes 

osd_seat_belt 
 

Yes 

osd_engine_coolant_temperature_high  Yes 

osd_engine_oil_temperature_high 
 Yes 

osd_DPF_filter 
 Yes 

osd_DPF_temperature_warning 
 

Yes 

osd_DPF_inhibit 
 Yes 

osd_turning_lamp  Yes 
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osd_maintenance_required 
 

Yes 

osd_warning_triangle 
 Yes 

osd_water_in_fuel  Yes 
osd_rabbit 

 Yes 

osd_turtle 
 

Yes 

osd_high_beam 
 

Yes 

osd_working_light 
 

Yes 

osd_rotating_light 
 Yes 

osd_charging 

 

Yes 

osd_warning_orange 
 No 

osd_full_battery_level 
 

No 

osd_green_battery_level_5_step 
 

No 

osd_green_battery_level_4_step 

 
No 

osd_yellow_battery_level_3_step 

 
No 

osd_orange_battery_level_2_step 

 
No 

osd_red_battery_level_1_step 

 

No 

osd_empty_battery_level 

 

No 
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B Troubleshooting 
 
 

Issue Possible cause Workaround 
 
When you open a project you get the 
error message “Project generated with a 
newer eDash”: 
 

 
 

 
The project was created/edited with a 
newer version of the program than 
the one is being used to open it. 
 
eDash application has been 
downgraded to an older version. 

 
Install the most recent version 
of eDash. 
 

 
When you attempt to execute “Run on 
Device” you get the error message 
“build_firmware.sh could not be started”: 
 

 
 

 
Any of the applications for advanced 
settings is not available. 

 
Check that the software for 
advanced settings is properly 
installed (see Chapter 6). 

 
While downloading the project to the 
device the process gets stuck with the 
message “discovering device, please 
wait”: 
 

 
 

 
Device cannot be reached to 
download the project on it. 
 

 
Check that the device is 
correctly powered and 
connected to the PC. 
Check that the USB-CAN 
converter is powered (red LED 
constantly lit). 
 
Check that the USB-CAN 
converter drivers are correctly 
installed, and that the converter 
is therefore visible in Windows 
in the Device Management 
window in the CAN-Hardware 
section. 

 
 
For more details see Chapter 5. 
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Issue Possible cause Workaround 
 
When you attempt to execute “Run on 
Device” the firmware is not being 
generated and an error is produced: 
 

 
 

 
There are syntax or logic errors in the 
Custom Logic file. 
 

 
Check the Custom Logic file 
carefully to make sure there are 
no errors. 
 
If you did not intend to produce 
any custom logic, try replacing 
its file with that of a new project 
created from scratch. The 
custom logic file is named 
custom_logic.c and can be 
found in the user_src folder 
within the project. 
 

 
When you attempt to execute “Run on 
Device” with a Slim Titan device you get 
the error message 15 “Graphic partition 
size is too big”: 
 

 
 
The message appears even if memory 
occupation looks significantly lesser than 
the limit: 

 
 

 
The project contains Background 
Image objects  

 
of large size. 

 
Verify that the project does not 
contain background images of 
overall size (uncompressed) 
greater than 1.5 MB. 
 
If the project contains more 
than one background, it is also 
possible to verify that the 
loading of the project is 
successful by removing the 
background images and then 
adding them one at a time, until 
identifying which image causes 
the exceeding of the size of 1.5 
MB. 
 
Refer to Chapter 7 of this 
manual for more information 
and tips on how to manage the 
available memory. 
 

 
When you attempt to execute “Run on 
Device” with a Slim Titan device you get 
the following error message: 

 
 

 
The checksum value on the Slim 
Titan device can’t be accessed by 
eDASH (for example in case a 
previous writing has been interrupted 
and / or has not been successful) 

 
Flash the device once by 
holding down the CTRL key on 
the keyboard; this way the 
writing of the firmware is forced 
through, rebuilding the 
checksum and eliminating any 
inconsistent values. 
From then on it is no longer 
necessary to keep the CTRL 
key pressed with each 
programming. 

 
When the Slim Titan instrument is started 
up after programming, the following 
image appears on the display: 

 
 

 
The writing of graphic data was 
intentionally interrupted or the device  
got turned off while writing of graphic 
data was under way 

 
Flash the device once again by 

pressing “Run on Device”  
again in the eDASH toolbar 
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